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Our Project

We completed a redesign of our client’s storefront, ChristiaDon (christiadon.com). ChristiaDon
is a fashion brand that is founded on legacy and quality, and supports self-love and self-
confidence through fashion. We created a new, independent website for ChristiaDon that focuses
on customer experience and streamlined appearance while maintaining the message and
storytelling from the original website.

Redesigned Website: https://christiadon.wordpress.com/

Additional Documents:

e Continuity Plan for the Client: Page 2-38
e Web Hosting Options: Page 39-50
e Style Guide: Page 51-55
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WordPress Continuity Plan

Purpose

The purpose of this document is to ensure that the client, ChristiaDon, has the basic information
and procedures needed to update the ChristiaDon WordPress website after the final deliverable is
submitted.

Summary

This document is a beginner’s tutorial to developing and updating a website on WordPress.
Though WordPress has its own tutorial service, this document is intended to teach the client the
features of WordPress based on the specific needs of the ChristiaDon company, and the specific
methods that the team members used to build the website. Group 1 (Bianca Bundy, Briah
Christia, Amelia Frederick, Jenna Luna, and Beth Winkopp) encourages you to do your own
exploration of the WordPress services in addition to this plan.

The sections of this document include:
® A Quick Introduction to WordPress
o Creating an Account
o Choosing a Payment Plan
e Understanding Your Main Dashboard

My Home o Feedback

o Stats o Jetpack

o Upgrades o Appearance

o My Mailboxes o Plugins

o Posts o Users

o Media o Tools

o Pages o Settings

o Comments o Add new site

e Customizing Your Website

o Creating a New Page o Updating Pages
Adding a Title o Appearance Settings

o Inserting Blocks m Themes

o Grouping Blocks m Editor

o Useful Block Suggestions for m Customize
ChristiaDon

Launching Your Website

E-commerce Integration
WordPress Resources and Troubleshooting


https://wordpress.com/learn/courses/getting-started/
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A Quick Introduction to WordPress

WordPress is a software content management system that specializes in web content. Initially
released on May 27, 2003 by founders Matt Mullenweg and Mike Little, WordPress was
originally created as a customizable blogging platform but has grown to one of the most popular
website builder and hosting platforms. Known for its user-friendly interface, WordPress requires
little coding knowledge and is a good option for those unfamiliar with website building.

WordPress is an all-in-one website builder and website hosting platform. A website builder is
what you use to create the interface of the website. This includes website pages, payment
options, and aesthetic choices. A website host is a service that allows people to access your
website through the internet. WordPress offers both of these services to users, but it can be used
as both a website builder or a website host separately. ChristiaDon uses WordPress as both a
website builder and a website host.

Creating an Account

Though the Group 1 team has already created a website for ChristiaDon and has transferred the
administration, understanding the basics of creating an account and setting up a new website will
be useful for future business endeavors.

1. To create an account, visit the WordPress account creation page at:
https://wordpress.com/start/domains

2. The WordPress website will prompt you to choose a domain name.

a. A domain name is the name of your website that appears in the URL. All-in-one
websites often include extra words to the domain name if you do not connect a
custom domain (ex. Christiadon.wordpress.com vs. christiadon.com).

3. After choosing a domain, the WordPress website will prompt you to choose a payment
plan. For more information about payment plans, see the Choosing a Payment Plan
section.

4. The WordPress website will prompt you to choose a website template from their free
template gallery. Choose a template that suits your website needs the best. For
ChristiaDon, we chose the Atfar theme because it has a luxurious feel.

5. After choosing your template, you will be directed to your main dashboard. For a guide
to your main dashboard, visit the Understanding your Main Dashboard section.
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Choosing a Payment Plan

WordPress has six different payment plan options to suit their users needs. Below is a table that
compares the pros and cons of the five most accessible payment plans for new users (taken from
the Website Hosting Options document):

Subscription | Pricing Pros Cons
type
Free $0 per month e Unlimited web e 10% transaction fees
pages for payments
e Unlimited e | GB of data uploads
collaborators e Limited
e Edit history customization
e Newsletter service
e Subscription
service for
customers
e Visitor statistics
e (Contact form
Personal $9 per month e All benefits in Free e 8% transaction fees
plus... for payments
e Ad free experience e Limited
e 6GB of data customization
uploads
Premium $18 per month e Everything in o 4% transaction fee
Personal plus... for payments
e Adrevenue
e Advanced
customization
e 4K video uploads
e 13 GB of data
uploads
e Ability to receive
donations and tips
Business $40 per month e Everything in e Higher cost
Premium plus... e Most plugins are
e Ability to install paid
plugins
e Malware protection
e 2% transaction fees
e Website backups
e Auto-updates
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SEO tools
Live chat support
50 GB of storage

Commerce

$70 per month

Everything in
Business plus...
Unlimited products
Product add-ons
(personalizations,
gift wrapping)
Referral programs
Automated
marketing
Shipping
integration

Sell worldwide
Bulk order
discounts

Higher cost

Most plugins are
paid

Harder to manage
without a dedicated
team

WordPress also offers an Enterprise subscription that starts at $25,000 annually. This

subscription is for large corporations like Disney, CNN, and Salesforce.

Please note that the website that Group 1 created for ChristiaDon uses the Free
subscription payment plan. If you would like to update your payment plan to access more
features, visit the Upgrades tab of your Main Dashboard.
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Understanding Your Main Dashboard

The Main Dashboard is the central hub of your WordPress website. From here, you can change,
review, and create almost anything regarding your website, your payment plans, and your
plugins. This section covers what each tab on the left column of the Main Dashboard can do for
you and the ChristiaDon website.
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Please note that the images in this section may look slightly different than what you will see on
your Main Dashboard. Group 1 is writing this Continuity Plan in the final stages of the website’s
completion, which may cause slight discrepancies in the deliverable that you receive. None of
these discrepancies will change the appearance or functionality of the ChristiaDon website.
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My Home

# My Home

The My Home tab on the Main Dashboard menu will bring you to the home page of your Main
Dashboard. Here, you will be able to access all of the different features of your WordPress
website. The Main Dashboard is split into two sections: the main menu and the display page.
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The main menu is the navy column on the left of the screen, and is used to navigate through all
of the different sections of your WordPress website. The display page is the landing page that
shows the contents of the menu tab that you are currently navigating.

On the My Home landing page, you will find a graph with your website statistics at a glance.
You will also find Quick Links on the right side of the screen. These Quick links will help you
quickly navigate through important action items like editing your website, adding a new page or
post, and managing your domains and plugins. Each of these action items will be detailed later in
the Continuity Plan.
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Stats

The Stats tab of your Main Dashboard provides you with statistics about your website visitation,
visitor analytics, and subscriber statistics (subscribers are visitors who have subscribed to your
email newsletter). These statistics are powered by JetPack, WordPress’s built-in site analytics
software. For more information about JetPack, visit the JetPack section of the continuity plan.

Jetpack Stats
Learn more about the activity and behavior of your site's visitors. Learn more

Traffic Insights Subscribers Q

7_day highlights Compared to previous 7 days

28 N r =
Visitors Views Likes Comments
0 0 0 0

The Stats page has three tabs to explore: Traffic, Insights, and Subscribers.

The Traffic tab tells you all about the activity of your site visitors. This includes:

e 7-Day Highlights: 7-Day Highlights are an overview of the visitor statistics of the past 7
days your website has been running for. You can also view an overview of the past 30
days of our website by clicking on the three vertical dots in the right corner of the 7-Day
Highlights menu.

e Views and Visitors: This section includes a graph of the amount of views and visitors
your website has received over a specified range of days, weeks, months, and years. This
is useful for tracking how many times visitors view certain pages.

o Visitor: an individual person who visits your website based on the first time the
individual’s browser is recognized by JetPack.
o Views: any time a visitor loads or refreshes any page of your website.

o Posts & Pages: The Posts & Pages section of the Traffic tab shows the most viewed
pages over a specified period of time.

o Referrers: The Referrers section shows how visitors found your website. This can be
through other websites or through the search engine they were using. The Referrers
section does not include visitors who type the ChristiaDon website URL directly into
their browser, click an email link, or click a link from social media websites.
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e Countries: The Countries section shows you how many views your website has received
from countries across the world. These statistics are only based on visitors that JetPack
can recognize their location by.

e Authors: The Authors section shows you how many views your website has produced
based on the authors of each page. Authors are the individuals who have created the page.
Currently, the authors of the ChristiaDon website are the member of Group 1.

e Search Terms: The Search terms section shows what terms visitors used to find your
website through search engines.

® Clicks: The Clicks section shows the number of times your website visitors have clicked
on links on your website.

e Videos: The Videos section shows the amount of views per video that is uploaded on
your website. This includes the number of times the video was loaded on a page, the total
number of hours watched, and the amount of times the visitors have viewed the video.

e Emails: The Emails section shows how many people opened or clicked a link on an
email that you have sent. This section only applies to people who have subscribed to your
email newsletter.

e File Downloads: The File Downloads section shows the files that visitors have
downloaded from your website.

The Insights tab provides a larger, long-time overview of your website statistics. This includes:

e Year in review: The Year in review is the number of posts, words, likes, comments, and
subscribes your website has garnered throughout the current year.

e All-time highlights: The all-time highlights includes your all-time views, visitors, posts,
and comments, as well as the most popular time of day your website is visited and the
day your website had the most views.

e All-time insights: The all-time insights shows the total amount of views per month that
your website has been running for.

e Shares: The shares shows you a summary of the amount of times your website has been
shared to social media platforms.

The Subscribers tab shows you insight about your subscribers that have subscribed to your
newsletter. This includes:
e All-time stats: The all-time stats shows you the total number of subscribers that have
signed up for your newsletter.
e Subscribers: The subscribers graph shows you the amount of subscribers that have
subscribed to your newsletter per day, week, month, and year. You can also view a list of
your subscribers, and the total amount of subscribers you have.
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Upgrades

= uUpgrades Free

The Upgrades tab of your Main Dashboard is where you can update or maintain all of your paid
subscriptions to WordPress payment plans and add-ons. The Upgrades tab includes:

e Plans: The plans tab is where you manage your payment plans. For more information
about payment plans, visit the Choosing A Payment Plan section of this Continuity Plan.

e Add-ons: The add-ons tab is where you can expand the functionality of your website by
paying for additional features like premium themes, expanded storage, and additional
JetPack features.

e Domains: The domains tab is where you can manage the domain names for your website.
The free WordPress plan uses a domain that includes WordPress in the name
(christiadon.wordpress.com). WordPress offers a promotion of a free one-year domain
registration with any paid payment plan.

e Emails: The emails tab is where you can manage custom email addresses. With any paid

WordPress subscription, WordPress allows you to set up a custom email that uses the
domain name of your website in the domain of your email (ex. don@christiadon.com).

e Purchases: The purchases tab is where you can view, manage, or cancel any plans,
purchases, or add-ons for your website. You can also view your active payments, your
billing methods, and any payment methods you have used.

My Mailboxes

My Mailboxes

The My Mailboxes tab of your Main Dashboard is similar to the Emails tab in the Upgrades
section of this Continuity Plan. The My Mailboxes tab is where you can manage your custom
email addresses.

To create a custom email address, you must have a paid subscription payment plan to
WordPress. Since the version of the ChristiaDon website that Group 1 has created for you is a
free subscription payment plan, you do not have access to My Mailbox. To choose a paid
payment plan, visit the Choosing a Payment Plan section of the Continuity Plan.
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Posts

The Posts tab of your Main Dashboard allows you to manage all of your posts on your website.
Posts are time-related content that you can post to your website. Posts are most often used by
users who use WordPress as a blogging website, however, posts can still be useful for
ChristiaDon in other ways. For example, creating a post could be a good way to announce a new
collection. The Posts tab is separated into four sections: all posts, add new post, categories, and
tags.

The All Posts section allows you to view, edit, publish, or unpublish all of the posts that you
have created on your website. This tab organizes all of your posts into four categories: published,
drafts, schedules, and trashed.

e Published: The Published tab will show you the posts that are accessible to view by any
visitor that visits your website.

e Drafts: The Drafts tab will show you which posts are saved as drafts, or posts that have
not yet been published.

e Scheduled: The Scheduled tab will show you which posts are scheduled for a certain
time on a certain day. This post would be useful for automatically releasing new
collections without having to manually publish the posts.

e Trashed: The Trashed tab will show you all of the posts that you have deleted from your
website. Think of this tab as an archive of all of the posts that you have created in the
past.

The Add New Post tab allows you to quickly add a new post to your website. To add a new post
to your website:
1. Navigate to the Posts tab on your Main Dashboard.
2. Click on the “Add New Post” section under the Posts tab. This will bring you to a screen
to begin working on your new post. Posts are created and edited in the same way as
Pages. To learn how to create and edit pages, please see the Creating a New Page section
of the Continuity Plan.




WordPress Continuity Plan

Elo o

Post Block X

I'd = @ christiadon.wordpress.com Customize your domain X

Add title Summary ~

Visibility Public
Type / to choose a block

Publish Immediately

Template Single Posts

URL christiadon.wordp
ress.com/?p=488

[ stick to the top of the blog

D Pending review
AUTHOR

bi320858 -

Excerpt ~

Access @ ~

The Categories tab allows you to create, edit, and manage the categories of your posts.
Categories are a way to add a hierarchical organization to your posts. You can use the Categories
tab to sort your website’s posts into different sections.

The Tags tab allows you to create, edit, and manage the tags on your posts. Tags are another
categorizing tool that allows you to organize your posts, but also allows visitors to gain an
understanding of your post. Tags are similar to keywords and can be used for Search Engine
Optimization.

Media

The Media Tab of your Main Dashboard allows you to manage all the media on your website.
Media includes images, documents, videos, and audio files that appear on your website.

Images are the main media type that ChristiaDon uses to showcase all of the products that are
sold on the website, and you can upload images from your computer to the WordPress website
through the media tab. You can upload images two different ways:
1. Upload an image through your computer files
a. Click the red “Add new” button at the top of the Images section of the Media tab.
This will bring up your computer’s files.
b. Click on the image that you want to upload to your website.
c. Click “Upload.” You image will appear under the Images section of the Media
tab.
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2. Upload an image through a URL.
a. Ifyouhave a URL for an image, click on the downward facing area on the red
“Add new” button at the top of the Images section of the Media tab.
b. Copy and paste the image URL into the box provided.
c. Click the red “Upload” button. Your image will appear under the Images section
of the Media tab.

Pages

The Pages tab of your Main Dashboard allows you to create, edit, and manage all of the pages on
your website. This tab is separated into two sub-sections: All Pages and Add New Page.

View v
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Create, edit, and manage the pages on your site. Learn more.

Published (8)  Drafts (0)  Scheduled (0)  Trashed (& Me Je)
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®7daysago  # Homepage

Edit

Store
@ 3 hours ago < \iew page
[ sStats
Policies "
z [E] Copy page
@® 3 hours ago
&2 Copy link
FAQ

@© 3 hours ago . t.»—' :' .
Sustainability
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The All Pages tab allows you to directly manage or edit any of the pages on your website. This
tab organizes all of your pages into four categories: published, drafts, scheduled, and trashed.
e Published: The Published pages tab will show you which pages of your website visitors
can currently access. Group 1 has published a home page, a store page, a policies page, a
FAQ page, a Sustainability page, an About Us page, and a Contact Us page for the
Christia Don website. Each page has a menu that can be accessed by the three vertical
dots menu on the right of each page section.
o [Edit: This option allows you to edit an existing page. For more information about
editing a page, visit the Updating Pages section of the Continuity Plan.




WordPress Continuity Plan

o View Page: This option allows you to view what a page looks like to your
website visitors on your website.

o Stats: This option allows you to view the views, likes, and comments of the page,
as well as how many emails were opened that included the page, and how many
people clicked on the page from an email.

Copy page: This option allows you to make a copy of a page that already exists.
Copy link: This option allows you to copy the direct link to the page on your
website.

o Trash: This option allows you to delete a page from your website and from your
drafts or your scheduled pages sections. The trashed pages are still accessible
from the Trash section of the All Pages tab.

e Drafts: The Drafts tab will show you which pages are saved as drafts, or pages that have
not yet been published. In addition to the edit, copy page, and copy link options from the
Published page tab, the three vertical dots menu on the right of each page section
includes:

o Publish: If a page is ready to be turned from a draft into a published page on your
website, use this feature. Publishing a page will make is accessible by website
visitors.

o Preview: The preview option will allow you to view what the page will look like
to website visitors without publishing the page to your website.

e Scheduled: The Scheduled tab will show you which pages are scheduled for a certain
time on a certain day. This page would be useful for automatically releasing new
collections without having to manually publish the pages.

e Trashed: The Trashed tab will show you all of the pages that you have deleted from your
website. Think of this tab as an archive of all of the pages that you have created in the
past.

The Add New Page tab allows you to create a new page to add to your website. For more

information about creating a new page, visit the Creating a New Page section of the Continuity
Plan.

Comments

The Comments tab of your Main Dashboard allows you to view, reply to, and manage all of the
comments that you receive on your website. The ChristiaDon website that Group 1 created does
not utilize comments. If you choose to use comments in your future business ventures, please
refer to the official WordPress guide to comments at:
https://wordpress.com/support/comments/
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Feedback

F=] Feedback

The Feedback tab of your Main Dashboard is separated into three subsections: Form Responses,
Crowdsignal, and Ratings.

The Form Responses section is where you can view the responses to the Contact Form that is
included as a page and footer of your website.

Columns
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Pagination

MNumber of items per page: | 20

View mode

®) Compact view Extended view

Form Responses
All (0)

Screen Options &

All sources v ‘ Filter |
From Source Date Response Data
MNo responses found

From Source Date Response Data

From this section, you can change the view of each form response:

o Columns: Using the column option, you can choose to include the type of form the
response comes from, the source of the form, the date the form was completed, and any
data associated with the response.

e Pagination: Using the pagination option, you can specify the number of form responses
you can view per page.

e View mode: Using the view mode option, you can either view your form responses in a
compact view or an extended view. A compact view shows you only the Form, Source,
Date, and Response Data of the response. An extended view shows you a greater range of
information about each response.

The Crowdsignal section allows you to manage data from any Crowdsignal items that you
include on your website. Crowdsignal is a WordPress powered analytics plugin that gives you
statistics and insights into your audience by providing powerful forms and surveys. Since
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Crowdsignal is a plugin, you have to have a paid subscription payment plan to use it. Group 1
created the ChristiaDon website using the free subscription payment plan, so you will not have
access to Crowdsignal unless you upgrade. To upgrade your payment plan, visit the Choosing a
Payment Plan section of this Continuity Plan.

The Ratings section is where you can view and analyze any of the ratings that your website may
have received. The ChristiaDon website that Group 1 created does not utilize the rating system,

but if you are interested in Ratings, please view the WordPress tutorial for Ratings.

Jetpack

Jetpack is a WordPress toolkit that specializes in security, site analytics, and growth tools for
your website. Some of the tools in the toolkit are included for free, while some of them require
an additional subscription fee to use. The Jetpack tab is separated into four sections: Activity
Log, Backup, Search, and Akismet Anti-spam.

e Activity Log: This section allows you to view all of your website’s activity, and who
made what changes. You can view post and page updates, user logins, plugin and theme
updates, setting changes, and more.

e Backup: To access and restore backups of your website, you need to upgrade to a
Business Plan. To learn how to upgrade your plan, visit the Upgrades section of the
Continuity Plan.

e Search: JetPack Search is a JetPack add-on that improves the quality and results of the
visitor search experience on your website. This add-on requires a payment before you can

access it.

e Askimet Anti-spam: Askimet Anti-spam is a free WordPress software that helps prevent
spam attacks from happening on your website. Here, you will be able to change the Aski-
met Anti-spam settings, including comments, spam filtering, and privacy settings.

Appearance
2¥ Appearance

The Appearance tab of your Main Dashboard allows you to access board editing features of your
website such as Themes, Advanced Customization, and the Main Editor. For more information
about the Appearance tab and how to use each feature, visit the Appearance Settings section of
the Continuity Plan.
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Plugins

The Plugins tab of your Main Dashboard allows you to search and download WordPress-
compatible plugins. Plugins are additional, typically third-party features that you can add to your
WordPres website to enhance different aspects of your website. You must be on a paid
subscription payment plan on WordPress to be able to use plugins. Some plugins also require an
additional fee to use in addition to the paid WordPress subscription plan.

Though the version of the ChristiaDon website that Group 1 has created does not utilize plugins
because we used the free subscription payment plan, a list of some of the most popular plugins
used by WordPress users is provided below (each plugin has over 5 million active users!):

e Contact Form 7: Contact Form 7 allows users to create more advanced and
customizable forms and email newsletters, including CAPTCHA filtering and spam
filtering.

e Elementor Website Builder: Elementor Website Builder allows users to create
advanced websites by using widgets and special features. While WordPress requires
some amount of coding for certain aspects of the website’s design, Elementor can help
users manage these aspects without it.

e Yoast SEO: Yoast SEO allows users to access advanced and supportive tools that will
broaden the SEO (search engine optimization) of their websites.

e C(lassic Editor: Classic Editor is a plugin developed by the WordPress team that allows
users to view previous versions of the WordPress editor screens. This is useful for people
who have learned how to use WordPress in a previous version.

e WooCommerce: WooCommerce allows users to create a complex e-commerce platform
attached directly to the WordPress website. WooCommerce is a reliable alternative to
Shopify if you ever choose to change to a different shopping platform.

Users

o Users

The Users tab of your Main Dashboard allows you to manage who has access as an administrator
or editor to your website, as well as manage your subscribers. The Users tab is separated into
three sections: All Users, Add New, and Subscribers.

The All Users section allows you to manage the current users of your website. The main page of
the All Users section shows you who the current and pending team members are.
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Users
Invite team members to your site and manage their access settings. Learn more.

Team (5 jol

You have 1 pending invite

Editor

You have 5 team members

A4

Editor

You also have access to view User details. This includes their display name, their role, and the
choice to remove the user.
e User name: This is the name that appears on the on the user’s profile elsewhere on the
website.
e Roles: There are four different roles that WordPress offers for users:
o0 Administrator: The Administrators have access to all the administration features
within the website.
o Editor: The Editors can publish, manage, and edit posts and pages made by any
user on the website.
o Author: The Authors can only publish, create, and edit their own posts, and not
the posts of other.
o Contributor: The Contributors can create and edit their own posts, but cannot
publish them or edit the posts of others.
e Removing a user: To remove a user from the website that you are currently working on,
click the red “Remove” button at the bottom of the User details screen.
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€ Back User Details
| Editor |
Role
Editor

Has access to all posts and pages.

This user is a contractor, freelancer, consultant, or agency. ()

This user has a WordPress.com account, only they are allowed to update their persona

information through their WordPress.com profile settings.
i remov I

The Add New section allows anyone with an Administrator role to add new team members to
your website. To add a new team member, follow the instructions below:
e Click the Users tab on the Main Dashboard. This will open up the Users menu.
e (lick on the Add New tab.
e Choose the role of the new team member using the drop down menu titles “Role.”
e Enter the email of the new team member. This will send the team member an invitation to
join the team of your website. You may also choose to add a message with the invitation.

& Back Add team members to ChristiaDon

Role

Editor

Has access to all posts and pages. Learn more

Email or Username

This user is a contractor, freelancer, consultant, or agency. ()

+ Add a message

Send invitation
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The Subscribers section allows you to manually add new subscribers to your website. To add a
new subscriber to your website:
e Click the red Add Subscribers button on the top right corner of the subscriber page. This
will prompt a pop-up window to open.
Enter the emails of the subscribers that you would like to add.
Click the red “Add subscribers” button on the bottom right corner of the pop-up window.
This will add the new subscribers to your email newsletter list.

Add subscribers to ChristiaDon

Email

| bestie@email.com

| chrisfromwork@email.com

| family@email.com

Or upload a CSV file of emails from your existing list. Learn more.

Add subscribers

Tools

The Tools tab of your Main Dashboard allows you to manage advanced website tools like
marketing, monetization, and importing or exporting website content. The Tools tab is separated
into four sections: Marketing, Monetize, Import, and Export.

Marketing:

Monetize:

Import: The import section allows you to import content from over 11 other websites or

platforms into your website.
e Export: The export section allows you to export content from your website to other
WordPress compatible websites or platforms.
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Settings

Settings

The Settings tab of your Main Dashboard allows you to manage the settings across multiple
areas of your website. The areas include: general, writing, reading, discussion, newsletter,
podcasting, performance, hosting configuration, and media. The ones that pertain most to the
ChristiaDon website are general, newsletter, and media, but you should explore all of the
setting options to choose the setting that best suits your website’s needs.

In the General settings section, you can change your general site settings. This includes your:
Site title, icon, tagline, and address
e Language and timezone
e Footer credit
e Site tools like changing the site address, transferring your site to another user or payment
plan, deleting your site’s content, or deleting your site permanently.
In the Newsletter settings section, you can manage your:
Subscriptions (this allows pop-ups with a subscribe form to pop-up on your website).
Email settings
Newsletter categories
Newsletter welcome and comment messages

In your Media settings section, you can manage your:
e Image sizes
e Image carousel settings (background colors, metadata, comments, titled galleries)

Add new site

Add new site

The Add new site tab on your Main Dashboard will allow you to create a new website,
independent of any of your existing websites. This button will direct you to a new page that will
prompt you to choose a new domain. To create a new website, visit steps 2 through 5 of the
Creating an Account section of the Continuity Plan.
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Customizing Your Website

Customizing your website is the key to drawing in your target audience. For the ChristiaDon
website, Group 1 decided on creating a sleek black and white theme to exude feelings of luxury
and simplicity, two of the core brand pillars of the ChristiaDon brand. The design choices are
simple, yet consistent which builds credibility between you and the consumer.

This section will detail the basics of customizing your website. Specifically, this section focuses
on creating posts and pages, which are the foundation of the new ChristiaDon website.

e Posts: Posts are used to display content and are dynamic, meaning that they are
sometimes associated with a specific date or time. Posts are typically used to give updates
on blog pages, but can be embedded onto a page to create individual product pages.

e Pages: Pages are used to display content and are static, meaning that they are not
necessarily associated with a specified date or time. For example, Group 1 used pages to
organize content like About Us, Contact Us, FAQ, Policies, etc.

Creating a New Page

There are two ways to create a new page: through the Quick Links menu on the My Home
display page, or by the Pages tab in your Main Dashboard.

To create a new page through the Quick Links menu on the My Home display page:
1. Navigate to your Main Dashboard.
2. Click the My Home tab on the left column of the Main Dashboard.
3. Navigate to the Quick Links section of your My Home display page. The Quick Links
section will be in the right column.
4. Click the “Add a page” link on the Quick Links menu.

To create a new page through the Pages tab in your Main Dashboard:
1. Navigate to your Main Dashboard.
2. Click the Pages tab on the left column of the Main Dashboard.
3. Click the “Add New Page” tab.

Both of these options will take you to the same “Add a page” pop-up menu.
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Add a page
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The “Add a page” pop-up menu allows you to either create a new page using a premade
WordPress page template, or create a new blank page. A template is an easier option for those
who are new to WordPress, as it provides you with a base to create your new page off of.
Creating a new blank page is a more advanced feature, but is useful for creating the exact look
and feel of your new page. Choose which option best suits your needs for a new page.

Group 1 chose to create the ChristiaDon website mainly from creating new blank pages, so this
guide will detail how to create a new page from a blank page.

Please note that you must save your pages after every edit that you make. To save your
page, click the blue “Save draft” button in the top right corner of the main editing menu.
To publish your page, click the blue “Publish” button in the top right corner of the main
editing menu (shown below).
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Adding a Title

You will want to add a title to your page to keep track of what pages you have, what pages you
need to create, and let your consumers understand what page they are on. The title that you give
a page will be visible by your audience, so make sure it accurately represents the page.

To add a title, click on the gray “Add a tile” text at the top of your new page. Type your title, and
press enter.

Type / to choose a block

Inserting Blocks

Blocks are components that allow you to insert elements and functions onto your WordPress
pages. Blocks gives you to flexibility to add media, embeds, text, surveys, forms, and more.
There are three ways to add a block to your page: by typing, by clicking on the black and white
plus sign, and by the main editing menu.

To add a block to your page by typing:
1. Click on any blank space on your page and enter a forward-slash. This will open up the
block mini-menu.
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2. The block mini menu suggests some of the most popular or recently used blocks that you
have used on your website. In this case, the most common blocks that this user inserted
were Heading, Group, Columns, Page List, Form, Subscribe, Buttons, Embed, and List.

3. Click on one of the blocks to insert it onto your page. Alternatively, begin typing a word
or phrase (ex. form) next to the forward-slash to pull up related blocks that are not shown
on the block mini menu.

4. Choose the block that you want to insert onto your page.

To insert a block by clicking on the black and white plus sign:
1. Click on any blank space on your page. This will prompt you to click the black and
white plus sign towards the right of the space.

Test Page

Type / to choose a block

Add block

2. Click on the black and white plus sign. The plus sign will turn blue and white when
hovering over it (shown above). This will open up another block mini menu.
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3. Using this block mini menu, you can search for different blocks using the search function
at the top of the menu, or click the “Browse all” option to open up the main block menu.
4. Choose the block that you want to insert onto your page.
To insert a block using the main editing menu:
1. Click on the blue and white plus sign in the main editing menu. The main editing menu is
the horizontal bar that extends across the top of your page. This will open the main block
menu as a column on the left side of your screen.

@ “ = Savedraft [ m [ > ]

Test Page

Type / to choose a block

2. The main block menu allows you to scroll through all of the blocks that WordPress
provides for your website. Group 1 encourages you to scroll through all of these blocks to
explore which ones will be the most useful to you.
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3. Choose the block that you want to insert onto your page. When you are finished, click the‘
black and white X in the main editing menu.

Grouping Blocks

Grouping blocks together allows you to connect multiple blocks into one bigger container.
Having multiple blocks grouped together allows you to access more advanced customizing
options for your page, like changing the background color and margin sizes.

There are two ways to group blocks together: adding new blocks to an existing group, or
adding existing blocks to a new group.

To add new blocks to an existing group:
1. Insert a new group block to your page. To learn how to insert blocks, please see the
Inserting Blocks section of the Continuity Plan.
2. After you insert the group block to your page, choose a layout option from the pop-up
window provided. Choose the layout option that best suits your needs.
3. Click on the black plus sign to start adding blocks to your group.

u -~
=1
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To add existing blocks to a new group:

1.

Select all of the blocks that you want to group on your page. You can select multiple
blocks by holding the Shift key on your keyboard and clicking the blocks.

Click on the group icon in the editing menu that appears above the selected blocks. After
clicking the group icon, your blocks will be placed inside a group.

This is a test page.

This page is used for testing.

Useful Block Suggestions for ChristiaDon

This section will detail some useful blocks that Group 1 used while creating the ChristiaDon
website, and some useful blocks that you might find useful in the future of ChristiaDon or in
other business ventures.

Some useful blocks that we used for the ChristiaDon website are:

Heading: The heading block allows you to add headings to your page. Headings are
useful for organizing a hierarchy on your page.

Paragraph: The paragraph block allows you to add any amount of text to your page.
Though the block is called Paragraph, the text that you insert on your page does not have
to be a full paragraph.

Image: The image block allows you to add images to your page. We used this block
often to upload pictures of products and logos. All of the images uploaded to the website
are saved under the Media tab on your Main Dashboard.

Buttons: The buttons block allows you to add buttons to your page. Buttons can be
linked to other pages on your website, or to external links. We used the button blocks to
link the store gallery to your Shopify payment website.

Columns: The columns block allows you to add columns to the formatting of your page.
This block is useful for organizing and adding visual interest to your page.

Contact Form: The contact form block allows you to add customer contact forms to
your page. The contact form will automatically create a form that prompts the customer
to enter their name, email, and message. Your contact form responses will be under the
Feedback tab of your Main Dashboard.

Some useful blocks that might be helpful for the future of ChristiaDon are:



WordPress Continuity Plan

o Slideshow: The slideshow block allows you to add a slideshow of images to your page.
This would be useful for showing different products or collections on a page.

e Event Countdown: The event countdown block allows you to add a countdown to your
website using a specified title and date. This would be useful for releasing new product
launches to your customers, and keeping a running timer to remind them every time they
visit your site.

e Repeat Visitor: The repeat visitor block allows you to write and send a certain message
to website visitors that have visited your website more than a specified amount of time.

e Comments: The comments block allows customers to write comments on your website.
This would be useful if you wanted to integrate a customer review system.

Updating Pages

After you have successfully created a new page using the Creating a New Page tutorial,
customized it to your liking, and published it to your website, WordPress will change the
location of your page from the draft section of your Pages tab to the published section of your
pages tab. (To learn more about how to navigate your pages, please see the Pages section of the
Continuity Plan).

To update your pages after they have been published:
1. Navigate to the Pages tab of your Main Dashboard.
2. Click on the page that you would like to update.
3. Make any changes necessary to your page. To learn how to edit your page, please see the
Inserting Blocks and Grouping Blocks sections of the Continuity Plan.
4. Click the blue “Update” button in the top right corner of the main editing menu (shown
below).
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Appearance Settings

The Appearance Settings tab of your Main Dashboard allows you to create a custom menu (also
known as a navigation bar, navigation menu, or main menu). It is a section of the site that helps
visitors to navigate the site. Depending on the theme used, typically a site will have one
navigation menu, while some themes may enable secondary or footer menus. It is essential to
have a simplified navigation menu, so as not to confuse your visitors.

In your menu, you can add different items such as links to pages, articles, categories, or custom
links to the url of your choice, such as another site, and then choose the order of the items and
their hierarchy (possibility of creating submenus). In short, your menu is fully customizable.

The Appearance Menus Screen is accessible from the Dashboard via Appearance > Menus.

Themes

WordPress Themes provide control over the visual presentation of your content and other data on
your WordPress site, as well as behavior of certain site’s elements while interacting with visitors.

A WordPress Theme is a collection of files that work together to produce a graphical interface
with an underlying unifying design for a website. These files are called template files. A Theme
modifies the way the site is displayed, without modifying the underlying software. Themes may
include customized template files, image files (*.jpg, *.png, *.gif), style sheets (*.css), custom
Pages, as well as any necessary code files (*.php).

You can switch between Themes from the Appearance menu in the Administration Screen.
Themes you add to the theme directory will appear in the Administration Screen >
Appearance > Themes as additional selections.
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Editor

The Site editor allows you to design the entire site including the header, footer, and everything in
between, with blocks. It gives you greater control over how your site looks.

.‘a WordPress 6.3
s

Design

Customize the appearance of your website
using the block editor.

To work with the Site editor, you need to use a block theme on your site. A block theme is a
theme that uses blocks for all parts of a site, including navigation menus, header, content, and
site footer.

All blocks that are available in the WordPress Block editor can be used in the Site editor. A set
of blocks called Theme blocks are specifically built for the Site editor.

Once you install and activate a Block theme on your site, go to Appearance > Editor to open
the Site Editor.

Once you enter the Site Editor, you will see five menu items.
1. Navigation: Allows you to browse your menus and make basic changes.
2. Styles: Provides a direct access to edit your site’s style variations.
3. Pages: You can now edit the content of your pages inside the Site Editor itself.
4. Templates: Review the different default layouts for the different sections on your site, as
well as custom pages (search results, 404, etc).
5. Patterns: Your Synced patterns and template parts can be managed here.
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You will also see an icon of a magnifying glass. Click on it to access the Command Palette.

Customize

Theme Customizer allows you to play around with various looks and settings for your current
theme or one you’re thinking about switching to without publishing those changes. For themes
that support it, you can change colors, backgrounds, custom image headers, and so on.

If you select Appearance -> Customize menu from the Administration Screens, Theme
Customizer is launched. The Customizer allows you to preview changes to your site before
publishing them. If you directly modify theme files and they are updated, then your
modifications may be lost. By using Customizer you will ensure that your modifications are
preserved.

To start the Customizer, follow one of these steps:
e From Administration Screens, Select Appearance -> Customize
e From Toolbar, Select Customize

To use Customizer, from left side menu, open the option category and specify the option value.
Notice that during your changes, the preview screen is also changed. After you finish the
customization, click the Publish button to enhance the changes to your site.

Launching Your Website

Though Group 1 has already launched the ChristiaDon website for you, this section details how
to launch a WordPress website. This section will be helpful for future ChristiaDon business
ventures, or if your website has been taken down for any reason.

WordPress is an all-in-one website builder and website host, so you do not have to take any
additional steps to link a website hosting service to your WordPress website. For more
information about website building and website hosting, visit the Website Hosting Options
document.



https://docs.google.com/document/u/0/d/13jjUc5TngewX9ap4lYDH7TtW_fWGRvq6bzp5_nSxDNo/
https://docs.google.com/document/u/0/d/13jjUc5TngewX9ap4lYDH7TtW_fWGRvq6bzp5_nSxDNo/

WordPress Continuity Plan

To launch your website:
1. Navigate to the My Home tab on your Main Dashboard.
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2. Click on the “Launch your site” link under the “Next steps for your site” heading on the
My Home display page.
3. Once you click on the “Launch your site” link, your website is available on the internet!

E-Commerce Integration

To integrate WordPress’s WooCommerce e-commerce into your WordPress site, you will need
to upgrade to the Commerce Plan.

Included in the Commerce Plan

The Commerce plan gives you:

WordPress hosting.

Everything included in the free version of WordPress.com.

Everything included in the Personal plan (free domain for one year, ad-free experience,
activity log, and more!)

e Everything included in the Premium plan (site customization, advertising, video uploads,
Google Analytics, and more!)

e Everything included in the Business plan (plugins, third-party themes, SEO tools,
backups, and more!)

e (reate unlimited products to sell physical goods, digital products and downloadable
files, personalized products (e.g., embroidered names), product bundles, and gift cards.
Leverage exclusive and professionally designed themes for stores.

Fine-tune your website’s design to match your brand.


https://wordpress.com/support/plan-features/#included-for-free
https://wordpress.com/support/plan-features/personal-plan/
https://wordpress.com/support/plan-features/premium-plan/
https://wordpress.com/support/plan-features/business-plan/

WordPress Continuity Plan

E-commerce features are provided by the WooCommerce plugin, which we automatically install

Use our large collection of blocks and patterns to showcase your products.
Customize your cart and checkout experience.

Process unlimited orders.

Earn recurring revenue with subscriptions (requires WooCommerce Payments.)
Sell on the most popular social media channels.

Issue coupon codes and run sales.

Offer product recommendations.

Capture lost sales with abandoned cart emails.

Automate your marketing campaigns to drive return purchases and grow your store.
View detailed analytics and segment your customers.

Integrations with top shipping carriers.

Accept payments in 60+ countries.

Automate your tax calculations.

Manage your store via the WooCommerce Mobile App.

24/7 support via email and live chat.

with your Commerce plan. The Commerce plan expands upon the WooCommerce plugin with:

A suite of handpicked WooCommerce extensions and tools to help you sell more types of

products and grow your business.
A streamlined navigation and store management experience that brings all the essential
functionality to your fingertips.

All extensions are designed to work seamlessly together to supercharge your store.
Extension updates are rolled out automatically for you, empowering you to focus on
growing your business — not managing plugins and updates.


https://wordpress.com/plugins/woocommerce/
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Getting Started

Your dashboard will guide you through a checklist to help you prepare to start selling. You may
skip this checklist whenever you want.

Home

You are on the right track

Add a way to get paid — -

3) Setuppayments

Adding products

Out of the box, WooCommerce allows you to create the following types of products:

Simple products: As the name suggests, a simple product is a product without variants.
For example, a book. You set a price, add a product description, set product images(s),
and publish the product. Your book is ready for sale!

Products with variations: Variable products are products with variations having
different SKUSs or prices. It can be a T-shirt in different sizes, colors, and fabrics or
software available in different licensing options. Each variation can have its own price,
stock, and SKU.

Physical or digital Products: Selling simple or variable products that don’t require
shipping? Mark them Virtual to disable all shipping-related fields and the shipping
calculator in the cart and checkout.

Products with downloadable content: Offer downloadable files on purchase. Simple
and variable products (each variation) can have download links added to them so when
someone orders the product, they can access the downloadable file either from the order
confirmation email or the Downloads section under the My Account page.
Affiliate/external products: Selling some products on a different platform? Let your site
visitors know by creating affiliate/external links so you can redirect them to purchase
those products.


https://woocommerce.com/document/managing-products/
https://woocommerce.com/document/the-my-account-page/
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In addition to these types of products, the extensions included in the Commerce plan allow you
to sell:

o Product bundles: Group existing simple, variable, and subscription products — and sell
them together. Learn more about the wide range of possibilities this product type has in
the Product Bundles extension documentation.

e Products with custom options and fields: Create products with different product
options to sell with your products. Add checkboxes, multiple-choice options, and text
inputs to let customers personalize your products. Learn how in the Product Add-Ons
extension documentation.

e Products with special quantity requirements: Learn how to add minimum, maximum,
and grouping rules to your products in the Min/Max Quantities extension documentation.

e Gift cards: Check out this guide to learn more about the supported gift card types and
take a deep dive into the features of the Gift Cards extension.

Setting up Payments

WooCommerce Payments lets you accept payments via credit cards, debit cards, Google Pay and
Apple Pay. Additionally, you can offer international buyers the option to shop in local currency
and pay via payment methods like Giropay, Sofort, iDeal, P24, EPS, and Bancontact.

WooCommerce Payments uses a pay-as-you-go model and is available in 18 countries.

Setting up Shipping

WooCommerce includes a collection of shipping methods such as Flat Rate, Local Pickup, and
Free Shipping by default. Read more about how to set up Shipping Zones and add Shipping
Methods here.

Additional E-Commerce Options

WordPress can also utilize other e-commerce tools, including Shopify, BigCommerce, and
wpEasyCart, to name a few. These are activated through plugins that can be installed with the
Business version of WordPress.



https://woocommerce.com/document/bundles/
https://woocommerce.com/document/product-add-ons/
https://woocommerce.com/document/product-add-ons/
https://woocommerce.com/document/minmax-quantities/
https://woocommerce.com/document/gift-cards/
https://woocommerce.com/documentation/plugins/woocommerce/getting-started/shipping/core-shipping-options/
https://www.shopify.com/buy-button/wordpress
https://wordpress.org/plugins/bigcommerce/
https://www.wpeasycart.com/
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WordPress Resources and Troubleshooting

WordPress has a large variety of free resources to help you better understand your website and
how to utilize its features to the highest caliber. This Continuity Plan offers a basic introduction
to how to use WordPress based on what we used for the ChristiaDon website, but there are
endless possibilities to customizing and polishing your website. Group 1 encourages you to take
advantage of some of WordPress’s resources to refine your website even further and develop
new customizations that follow the ChristiaDon legacy. Below are some WordPress resources
that you might find helpful in having a deeper understanding of WordPress and how it can help
you grow as a business:
o Go by WordPress: Go by WordPress is a blogging website that WordPress employees
use to create articles about specific topics intended to help WordPress users in developing
their websites. Below are some helpful blog topics to maintain or grow your WordPress

website.
o Website Building: The website building section has helpful tips and guides about

creating certain types of websites or features to integrate into your website.

o Digital Marketing: The digital marketing section provides guides about
monetization, SEO, newsletters, and other such topics relating to your business’s
marketing and customer service.

o Tutorials: In addition to having technical documentation, WordPress also offers
tutorials on Go by WordPress. These are helpful if you need a question answered
quickly and do not need a fully developed tutorial.

o WordPress Learn: WordPress Learn is a website that offers free webinars, courses, and
tutorials for users to utilize when developing their website. These items are great to

reference as you get further into developing your website.

o WordPress Semantics: The WordPress Semantics document helps users understand the
different jargon that WordPress uses to describe different aspects of the website. This
document is useful to reference when you begin editing or refreshing your website.

WordPress, even as strong and widely used as a platform, still faces technical issues on the front
and back end of the servers. The WordPress Codex for Troubleshooting is a great resource to

start troubleshooting any issues that you may face when launching or developing your website
further. The WordPress Codex for Troubleshooting helps users solve issues relating to
installation, design and layout, backups, databases, plugins, and much more. You can access the
Codex by clicking on this link: https://codex.wordpress.org/Troubleshooting .

If you cannot find the answer to your issue there, check out these other troubleshooting
resources that WordPress offers:
e WordPress Documentation: The WordPress Documentation website provides extensive
technical documentation and tutorials about anything relate to WordPress. This website is



https://wordpress.com/go/
https://wordpress.com/go/category/website-building/
https://wordpress.com/go/category/digital-marketing/
https://wordpress.com/go/category/tutorials/
https://wordpress.com/learn/
https://wordpress.org/documentation/article/wordpress-semantics/
https://codex.wordpress.org/Troubleshooting
https://codex.wordpress.org/Troubleshooting
https://wordpress.org/documentation/
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particularly useful as a supplement to this Continuity Plan if you need more information
about a certain topic.

o WordPress Support Forum: The WordPress Support Forum is a public forum for
WordPress users to ask questions and receive answers from WordPress community
members who have faced similar issues or direct answers from Wordpress employees.

e WordPress Internet Relay Chat (IRC) Live Help: The WordPress IRC chat is an
online chat forum that allows users to get help in real time. No account is required to use
the live chat feature, but make sure to follow the specified guidelines of the chat channel.

Source: https://wordpress.org/documentation


https://wordpress.org/support/forums/
https://web.libera.chat/#wordpress

Website Host Options

An Introduction to Website Creation

A website needs a website builder and a website host to be able to function on the internet
properly. A website builder is what you use to create the interface of the website. This includes
website pages, payment options, and aesthetic choices. A website host is a service that allows
people to access your website through the internet.

To create a website, there are two approaches you can take:

e All-in-one: An all-in-one approach is choosing a service that allows both website
building and website hosting in one subscription. This approach is better for small
businesses who only need one website to function.

e Separate builder and host: A separate approach is choosing a separate website builder
service and website host service. This is better for bigger businesses who need to
accommodate high amounts of traffic and more advanced hosting options.

Websites also need a domain name. A domain name is the name of your website that appears in
the URL. All-in-one websites often include extra words to the domain name if you do not
connect a custom domain (ex. Christiadon.weebly.com vs. christiadon.com). Separate website
builders and website hosts have more flexibility for you to create and connect your own domain
name. Unless website platforms include free custom domains, it is likely that you would have to
pay a separate fee to manage your own domain name and connect it to your website platform.

This document describes and compares popular all-in-one platforms and separate website
builders and website host platforms so you can choose what type of service is right for
ChristiaDon. This is not an exhaustive list, and we encourage you to do your own research in
addition to looking over this document. Our group is happy to explore other options if none of
these are what you are looking for.

All-in-one website builders and hosts

Square

Square is an online, all-in-one website builder and hosting service. Square is highly rated and
commonly used by restaurants, retail stores, and ecommerce sites because it is user friendly and
incorporates all the benefits you would need to start selling items in-person or online. Square
also offers physical Point of Sales Systems to use for brick and mortar stores, tabling events, and
any other in-person event you attend.


https://squareup.com/us/en/online-store

Website Host Options

Subscription | Pricing Pros Cons
type
Free $0 per month e Website builder & e (Cannot use custom
website hosting domain without paid
2.9% + 30 cent e Basic page layouts subscription
transaction fee e Integrate to social e Limited
media accounts customization
e Third party courier options without paid
shipping subscription
e Shipping rate e Transaction fees
discounts e No email marketing
e Accepts Cash App, options
Apple Pay, Google
Pay, Afterpay, and
major credit cards
e Unlimited Items
e Coupon creation
e Facebook ads
Plus $29 per month e All benefits of Free e No real-time
subscription plus... shipping
2.9% +30 cent e Custom domain e Transaction fees
transaction fee connection
e Add custom fonts
and branding
aesthetics
e Advanced
customization
options
e (Customers can
create accounts
e Pre-order option
e Accepts PayPal
e Free shipping
options
e Product reviews
e Customer
subscription
services
e View site traffic
and statistics
Premium $79 per month e All benefits of Plus e Transaction fees
subscription plus...
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2.6% + 30 cent
transaction fees

Free in-house
delivery

Real-time shipping
Discount on
transaction fees

Wix

Wix is an all-in-one website builder and website hosting service. It prides itself on being simple
and easy to use. While it has more limited features for ecommerce compared to the other
platforms in this document, it includes some unique features like multiple currency pricing and
large product listing abilities.

Subscription | Pricing Pros Cons
type
Light $16 per month e (Custom domain e Only 2 GB of data
connection & free e No customer
domain name for 1 accounts
year e No professional logo
e No Wix branding e No ability to sell
products
e No loyalty program
e No automated sales
tax
e Only 2 collaborators
e No information
about customizable
interface
Core $27 per month e All benefits of e No automated sales
Light subscription tax
plus... e No automatic third
e 50 GB of data party courier options
e (ustomers can e Cannot print
create accounts shipping labels
e Professional logo e Only 5 collaborators
e Accepts payments e No information
e (an create about customizable
members-only interface
content
e Ability to sell



https://www.wix.com/ecommerce/website
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products + up to
50,000 product
listings

Business $32 per month

All benefits of Core
plus...

100 GB of data
Automated sales
tax for 100
transactions per
month

Product reviews
Displays product
pricing in up to 5
currencies
Abandoned cart
recovery

Ability to print
shipping labels and
connect third party
couriers

No loyalty programs
Only accepts major
credit cards (no
PayPal, Apple Pay,
Google Pay, etc.)
No information
about customizable
interface

SquareSpace

SquareSpace is an all-in-one website builder and website hosting service. SquareSpace has
hundreds of website templates to use as a foundation before customizing to your needs.

SquareSpace has many advanced ecommerce options like advanced shipping, Google Workspace
integration, Facebook and Instagram integration, and unlimited product listings. SquareSpace
also includes a 14-day free trial to test the platform before you purchase a subscription.

Subscription | Pricing Pros Cons
type
Business $23 per month e Free custom e 3% transaction fee
domain for 1 year on online
e Website and traffic transactions
analytics e Unlimited
e Unlimited customization needs
contributors knowledge of CSS
e Free Google and Javascript
Workspace account coding languages
for one year e Payment for domain



https://www.squarespace.com/ecommerce-website
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(professional email
with domain in
address)
Promotional pop-
ups and banners
Unlimited product
listings

Customers can
create accounts
Accepts major
credit cards, Apple
Pay, PayPal,
AfterPay
Inventory + product
management
Integrates shipping
options

Unlimited
customization

Can sell digital
products
Squarespace
Extensions

Mobile optimized
websites

after one year

No information
about sales tax
Separate email
campaigns
subscription pricing

Commerce
Basic

$27 per month

All benefits of
Business
subscription plus...
0% transaction fee
Advanced
merchandising (low
product
notifications,
product waitlists,
display related
products)

Product reviews
Sell products on
Facebook and
Instagram

Payment for domain
after one year

No information
about shipping

No information
about sales tax
Separate email
campaigns
subscription pricing

Commerce
Advanced

$49 per month

All benefits of
Commerce Basic
plus...

Free shipping and

No information
about sales tax
Payment for domain
after one year
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dynamic shipping e Separate email

e Discount options campaigns

e Abandoned cart subscription pricing
recovery

e Subscription selling

Website Builders

WordPress

WordPress is one of the most popular and highly rated website builders by developers.
WordPress is a user-friendly CMS software because it requires little to no coding knowledge to
use and customize your website. WordPress is compatible with most website hosting services
because of its popularity. WordPress has its own website hosting options, but plans start at $25 in
addition to your website builder subscription. It is a good option if you want to have a broader
choice of website hosting platforms. WordPress also offers WooCommerce, a WordPress
powered eCommerce extension that gives more control over your product management.

Subscription | Pricing Pros Cons
type
Free $0 per month e Unlimited web e 10% transaction fees
pages for payments
e Unlimited e 1 GB of data uploads
collaborators e Limited
e [Edit history customization
o Newsletter service options
e Subscription
service for
customers

e Visitor statistics
e Contact form

Personal $9 per month e All benefits in Free e 8% transaction fees
plus... for payments
e Ad free experience e Limited

e O6GB of data customization



https://wordpress.com/pricing/
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uploads
Premium $18 per month e Everything in e 4% transaction fee
Personal plus... for payments
e Adrevenue
e Advanced
customization
e 4K video uploads
e 13 GB of data
uploads
e Ability to receive
donations and tips
Business $40 per month e Everything in e Higher cost
Premium plus... e Most plugins are
e Ability to install paid
plugins
e Malware protection
e 2% transaction fees
e Website backups
e Auto-updates
e SEO tools
e Live chat support
e 50 GB of storage
Commerce | $70 per month e Everything in e Higher cost
Business plus... ® Most plugins are
e Unlimited products paid
e Product add-ons e Harder to manage
(personalizations, without a dedicated
gift wrapping) team
e Referral programs
e Automated
marketing
e Shipping
integration
e Sell worldwide
e Bulk order
discounts
GoDaddy

GoDaddy is another highly rated and popular website building and website hosting service. The
website builder does not have a free version, and online store options start at the Commerce



https://www.godaddy.com/websites/website-builder/plans-and-pricing
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subscription for $16.99 per month. GoDaddy is unique because of its versatility in selling across
social media platforms like Amazon, Etsy, and facebook. GoDaddy is also a website hosting
service, which is a great option if you want to stick with one brand for all of your website needs.

Subscription | Pricing Pros Cons
type
Basic $9.99 per month e Custom domain e No online store
connection options
e Marketing analytics e No sales tax
dashboard calculator
e Website Chat Box
e Sales tracking
dashboard
o Email newsletter
sign up
e 100 marketing
emails per month
e SEO options
e Professional email
with your domain
name in the address
Premium $14.99 per month e All benefits in e No online store
Basic plus... option
e 25,000 marketing e No sales tax
emails per month calculator
e Facebook and
Instagram ads
Commerce | $16.99 per month e Everything in e 2.3% +30 cent
Premium plus... transaction fee
e 5,000 product e No sales tax
listings in online calculator
store
e Sell up to 50 orders
a month through
social media and
Amazon
e Online inventory
system
e Discounts and
promotions for
customers
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e Accepts gift cards

e Real-time shipping

e Order confirmation
and shipping emails
for customers

Commerce | $29.99 per month e Everything in o 2.3% +30 cent
Plus Commerce plus... transaction fee
e Unlimited product e No sales tax
listings calculator

e Sell up to 1,000
orders through
social media and
Amazon

e 10,000 marketing
emails per month

e Automatic sales tax
calculator

Website Hosts

Award Space

Award Space is a popular website hosting service because of its great benefits for low cost
compared to other website hosts. Award Space has unlimited monthly traffic, which means that
an unlimited amount of people can visit your website per month. Award Space also offers free
domain renewal after one year of using the platform as a loyalty program. This would help cut
down long-term costs on domains for your store. Free domain renewal after one year of using
Award Space, cutting down long-term costs on domains. With Award Space, you would have to
check if your website builder is supported by the platform. Award SPace also has limited domain
protection options, which could be a deterrent if you feel strongly about your personal
information being protected.

Subscription | Monthly Cost Pros Cons
Type

Basic e $6.99 per e Unlimited data e Must pay for domain



https://www.awardspace.com/web-hosting/shared-hosting/shared-hosting-features-table/
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month uploads name yearly ($17.95)
o $0.25 per 1,000 brand email e No customer mailing
month accounts list options
when Supports major e Domain Privacy
signing up coding languages Protection is $10.00
for first 99.9% uptime extra
year Built-in website
traffic reports
2 domains + 5
subdomains
Spam protection
Autoresponder for
email accounts
Unlimited monthly
traffic
Web Pro e $9.65 per All benefits in Basic e Must pay for domain
Plus month subscription plus... name once, but
e $7.57 per Unlimited brand comes with
month email accounts automatic FREE
when One customer domain renewal
signing up mailing list
for first
year
Max Pack e $13.99 per All benefits in Basic e Must pay for domain
Plus month and Web Pro Plus name once, but
e §£9.83 per subscriptions plus... comes with
month Unlimited domain automatic FREE
when names domain renewal for
signing up Three customer up to two domain
for first mailing lists names
year
BlueHost

BlueHost offers a lot of flexibility in terms of plans, but lower-cost plans limit the amount of
website visits your website can have during a month. BlueHost offers an Online Store

subscription, which includes unique features like email campaigns, website backups, shipping

options, and WordPress integration.



https://www.bluehost.com/pricing
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Subscription | Monthly Cost Pros Cons
Type
Basic $11.99 per month e One website e Only allows 15,000
e 10 GB of web storage website visit per
e Malware scanning month
e Free Wordpress e No email marketing
Integration options
e No domain privacy
options
Plus $16.99 per month e 2 websites e No domain privacy
e 50,000 website visits options
per month
e 20 GB of web storage
e Email marketing
options
e Malware scanning
e Free WordPress
integration
Choice Plus $21.99 per month e Everything in Plus e High cost per month
plan plus... if you’re also paying
e 3 websites for a website builder
e 200,000 website visits
per month
e 40 GB of web storage
e Free Wordpress
integration
e Free daily website
backup for 1st year
e Free domain privacy
for first year
e Performance insights
e Plugins
e Client invoicing
Online Store | $26.99 per month e 40 GB of web storage e High cost per month
e Free WordPress if you’re also paying
integration for a website builder
e Email campaign
creator
e Malware scanning
e Free daily website
backup for 1st year
e Automated Wordpress
updates
e Secure online
payments
e Unlimited products
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Provides shipping
options




STYLE GUIDE CHRISTIADON

MISSION

ChristiaDon’s goal is to instill confidence within individuals though their storytelling, art, and high
quality garments with effortless style and simplicity. ChristiaDon is built on the foundation of self-love
and growth.

CONTACTS
Main website https://christiadon.com/
Password: 2000
Instagram https://www.instagram.com/christiadon/
Support Email CHRISTIADON.CLO@GMAIL.COM
LOGOS AND BRANDING
MAIN LOGO

The ChristaDon logo should be shown with a clear or white background when possible.

christiadon.

When placed on a black or dark background the alternative logo should be opted for:


https://christiadon.com/

Style Guide ChristiaDon

ALTERNATIVE LOGO
When discussing branding history, or the ChristiaDon University collection, the 1978 alternative logo

should be used. This follows the same guidelines of the main logo, staying with a clear/white

background.

When working on a dark background, use the lighter grey version of the 1978 alternative logo to ensure
that readers can see the logo correctly.

COLOR PALETTE

The ChristiaDon brand uses basic coloring for their website. Unless otherwise stated, the background
should always be black or white.

LIGHT BACKGROUND
Style Color Pantone

Headings I
Paragraph N <M ATCH LOGO COLOR>

Background
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DARK BACKGROUND
Style Color Pantone
Headings
Paragraph <MATCH LOGO COLOR>

Background |

FONTS

All text should be in a readable font that is accessible and understandable.

LIGHT BACKGROUND
Text Type Font Size
Titles/Headings <NEED TO SEE WHAT
FONTS AVAILABLE BASED
ON WEBHOST>
Paragraph Text
Menu Items
DARK BACKGROUND
Text Type Font Size
Titles/Headings
Paragraph Text
Menu Items

VERBIAGE AND WORDING

All wording should be professional, but friendly like you are talking to a family member. ChristiaDon’s
brand wants customers to join the family, so having a familiar communication is key to the brand.

Refrain from slang, profanity, and abbreviation’s in any communication to the customer.

Correct Here at ChristiaDon we want you to join the family!
Incorrect Our clothes are lit, so we want you 2 join us!
REQUESTS AND ASKS
Requests and asks should never be “bossy” or “demanding”.
Correct “Place your order”
Incorrect “Buy Now!”

PHOTO GUIDES

All photos on the website should be official photos of models or staff wearing ChristiaDon clothing.
Focus of the photo should be the clothing, and all merchandise should appear clean and how it is intended
to be worn.
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<<EXAMPLE>>>

Photos being used OUTSIDE of the webstore should feature models in an organic setting, and not a
product item photo.

Use This Not This

Photos should be properly cropped and aligned with the text in an appealing way.

STORE IMAGE GUIDELINES

Models should be wearing the item for sale in the photo and the color variation should also be correct.
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FEATURED IMAGE
The item in mention should be the primary focus of the featured image.

IE — Pants should have a focus on the lower half of the model, and be a full body, or lower half body shot.

APPROVED PHOTOS
All approved photos can be found in the company Google Drive. Only approved photos should be

published on the official website.

LINKING

All links should be shown with a simple underline, to keep the black and white color scheme. Color may
turn blue when hovered over, but should be black when in basic mode.

BUTTONS
Buttons should be rounded shapes that hyperlink to the appropriate website, or add products in cart.

Sharp edges should not be used.

Correct Incorrect
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